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1 Installation 

1 Installation 

1.1 Computer system 
requirements
The recommended computer requirement is 
Windows® XP / Win 7 / 10.

1.2 Installing SVERKER Win
SVERKER win can be delivered on an USB memory 
stick or downloaded from Megger website.

Note	 If you have an old version of ProView PC 750 
or earlier version of SVERKER Win installed 
you must uninstall this first. 
Make a backup of previous saved test files.

1]	 Click on the istallation file 
"SverkerWin xxxSetup.exe". 

2]	 Select the language to use during installa-
tion.

Note	 A sample file for Custom help file in Word 6.0 
is included. 
 
You must have acrobat reader 4.0 (or later) 
to be able to read the documentation. The 
reader will be installed at the end of the in-
stallation, but you can cancel the installation if 
you already have version 4.0 or later installed.

3]	 The installation of SVERKER Win is now com-
pleted.

Change language
You can later on change language from ”File”, ”Se-
lect language”.

USB driver installation
A driver for the USB port on the SVERKER must be 
installed on your PC before you can use the USB port. 
The USB driver is in the SVERKER Win software.

Note	 SVERKER Win does not work with Windows® 
Vista.

1]	 Select the USB Driver folder and double click 
on the file:  
CP210xVCPInstaller_x64 for 64 bit systems or 
CP210xVCPInstaller_x86 for 32 bit systems.

2]	 Follow the installation instructions.

USB setup/Comport settings
1]	 Open Windows "Control Panel".

2]	 Choose "System".
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1 Installation 

3]	 Under the "Hardware" tab, choose "Device 
Manager".

4]	 Look at the "Ports (COM & LPT)" submenu. 
Since the SVERKER Win software cannot 
handle more than 7 comports, it is needed 
to check the comport number assigned 
automatically by Windows and change it to 
anything equal or lower than 7.

To change the comport number
1]	 Right click on the "USB-to-serial Comm. Port" 

and choose "Properties".

2]	 Under "Port Settings" tab, click on "Advanced"

3]	 Change the "COM Port Number" to anything 
equal or lower than "COM7"

Note	 Even if the ports are showed as "(in use)", it 
can be changed without problems. It is just a 
virtual usage by Windows.

4]	  Click OK

5]	 Answer “Yes” to following message:

"This COM name is being used by another device (such as 
another com port or modem). Using duplicate names can 
lead to inaccessible devices and changed settings. Do you 
want to continue?"

6]	 Start/Open SVERKER Win software.

7]	 In the toolbar, click on "File" and choose 
"System Setup"

8]	 In the "COMM PORT" scroll list choose exactly 
the same number as the one assigned earlier 
on (in the "Windows/Control Panel/System/
Hardware/Device Manager").
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1 Installation 

9]	 Click "OK".

10]	Exit/close SVERKER Win and re-start it.

Note	 Make sure you have the physical connection 
to SVERKER.
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2 Getting ready for use 

2 Getting ready for use 

2.1 Starting  
SVERKER Win
1]	 Connect the computer’s serial/USB port to 

SVERKER. 

2]	 Click on ”SVERKER Win”.

3]	 If the message “The Sverker you are connected 
to doesn't have any key for SVERKER Win in-
stalled!” appears on the screen, you have to 
“unlock” it, see below. You only have to do 
this once. After SVERKER has been unlocked 
once, it can be run from any computer on 
which SVERKER Win has been installed. 

If the communication cannot be 
established
Important  

The com port number assigned by Windows 
to the USB to serial must be the same as the 
one assigned in SVERKER Win.

Check the com port number assigned by 
Windows
1]	 Go to”Control Panel/System/Hardware/Device 

manager/Ports”

2]	 The number of the comm. Port should not 
be higher than 7. In case the number will be 
higher, change the number by double click-
ing on “USB-to-Serial Comm. Port”.

3]	 Go to “port settings” tab and click on “Ad-
vanced”.

4]	 Change Com Port number (1 to 7).

Check the com port number assigned in 
SVERKER Win
1]	 Start SVERKER Win.

2]	 Click on “File” in the toolbar.

3]	 Choose “System setup…”

4]	 Change COM PORT number to be the same 
as the one assigned by Windows.

5]	 Click on “OK” and re-start SVERKER Win.

Unlock SVERKER

1]	 When the message “The Sverker you are 
connected to doesn't have any key for SVERKER 
Win installed!” appears on the screen, press 
ENTER. 

2]	 The dialogue box shown in the picture above 
will appear. 

3]	 Insert the USB stick labelled ”SVERKER Win 
Software key”.

4]	 Click on BROWSE and select the file in "Re-
movable Disk". 

5]	 Click ”OK”.

6]	 Type in the serial number of the SVERKER, 
you will find it on the under side of the 
SVERKER. 

7]	 Click ”OK”.

8]	 The ”TEST SETTINGS” window will open.

Note	 Once you have unlocked your SVERKER (if you 
have bought a new SVERKER this is normally 
already done when you receive it) you can 
use this SVERKER with any computer that 
have SVERKER Win installed (you can install 
the program on as many computers as you 
like). This means you will not by mistake bring 
the “wrong” computer without any license 
installed.
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2 Getting ready for use 

2.2 Test settings

Here, you select the settings for your test. Conduct a 
trial by clicking on the different buttons and menus. 
The SVERKER User's manual explains how they func-
tion.

Auxiliary voltage

Note	 This is for SVERKER 760 and 780. 

The auxiliary voltage ranges can not be controlled 
from the SVERKER Win if you are connected to a 
SVERKER 760/780. In this case the auxiliary voltage is 
controlled directly with the dials on the panel

Timer settings

When you click on this icon, you open up the ”TIMER 
SETTINGS” window.

Here you set the conditions for the ”START” and 
”STOP” input, see the SVERKER User's manual for 
more information.

Meter settings

.

Any one of these two icons will open up the ”METER 
SETTINGS” window.

 

Here you set up the meters, see the SVERKER User's 
manual for more information.

Test header
1]	 Click on the ”OK” button in the ”METER 

SETTINGS” window. 
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2 Getting ready for use 

Here you enter the contents for the report. If you wish 
to rename a LABEL you can do so  under ”File”, ”Sys-
tem setup”, see below.

System setup
Here you can rename the Labels, enter the names and 
click OK.

You can also change  com port, com speed and delim-
iter. You chose suitable delimiter when you export to 
e.g. Excel.

2.3 Manage the test
1]	 Click on the ”OK” button in the ”TEST 

SETTING” window see"2.2 Test settings" on 
page 10.

This is the SVERKER Win window from which you con-
trol most of the test. The “Comments for selected trip 
point” field is used if you want to write a comment to 
the actual test shot, e.g. Pick-up test, this will then be 
printed in the report on the same line as the test shot.

For SVERKER 780 the the phase angle and the fre-
queny are displayed.
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2 Getting ready for use 

2.4 Tool bar

New test 

Open a test 

Save the test

Beginning of the log list

One step down in the log list

 
Number 7 in the log is displayed

One step up in the log list

End of the log list

Delete the settings and the result 
for the selected log number.

Undo delete

Test header, to add information for 
the report 

Test settings

Export result as an ASCII file

Print preview 

Print

Custom help

2.5 Oscilloscope
Depending on what ”TEST MODE” you have selected 
(”Normal”, ”Trip+pulse time” or ”Reclose”), the look 
of the black oscilloscope will differ. 

Normal

Reference graph
It is possible to create the theoretical reference graph 
to visually compare the test results with.

1]	 Press the “Reference graph” button.

2]	 In the Reference Graph setup you can select 
”Relay type” and use one of the ready-made 
relay curves for a specific relay instead of a 
characteristic.
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2 Getting ready for use 

It is also possible to create different types of inverse 
characteristics for e.g. overcurrent relays. There are 
several different types specified in the IEEE and IEC 
standards and also ABB RI (note: for ABB RI k = s/ 10) 
and ABB IDG. It also possible to select logarithmic 
scales. The reference graphs can be defined as fol-
lows:

Name on axis 

Here you can select values on the horizontal axis. 
”Extra 1” and ”Extra 2” can be used when you have 
selected any extra meter. ”Extra 2” can only be used 
if the extra meter have two values (e.g. Z and Zphi). 
”Extra 2” would then be the second value (Zphi in 
this case). However most commonly is probably to 
use ”Current” for testing the time characteristic of on 
overcurrent relay.

Scale of the axis
The scale of the axis can be set automatic or adjusted 
manually.

Reference graph for frequency test
To create a reference graph for a frequency relay 
choose "CONSTANT TIME" characteristic for a current 
relay.

1]	 Enter the settings as follows:

2]	 Step one: “I>>” will be the f1 setting and 
“t>>” will be the “t1” (operating set time for 
stage 1)

3]	 Step two: “I>” will be “f2” and “k” will be 
“t2” (operating time for stage 2)

Name on axis 
Choose Time/Extra1 in order to have a time/frequency 
reference graph.

Trip + pulse time

This shows two different times:  
T#00	 Trip time, the time for the relay to trip 
T#01	 Pulse time, the time for the Trip contact to 
release.

In this case it is not possible to create a reference 
graph.
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2 Getting ready for use 

Axis 
The axis can not be changed. The vertical axis, ”Cur-
rent” indicates:  
1 = Current ON  
0 = Current OFF

Reclose

This is a test of an overcurrent relay with autoreclose.

T#00	 trip time, the time for the relay to trip  
T#01	 dead time.  
T#02	 reclose time.  
…and so on depending on the number of recloses.

In this case it is not possible to create a reference 
graph.

Axis
The axis can not be changed. The vertical axis, ”Cur-
rent” indicates:  
1 = Current ON  
0 = Current OFF
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3 Conduct the test 

3 Conduct the test 

3.1 Define the reference 
graph
The reference graph can only be used in ”Normal 
mode”. The reference graph is used to visually com-
pare the test results with the theoretically settings of 
the relay.

1]	 Click on the ”Reference graph” button.

Tip 
If you for some reason do not want any 
reference graph, unmark ”Visible”. 

2]	 Select the type of reference graph curve. 
IEC is normally used in Europe and Asia. 
IEEE is normally used in USA.

3]	 Select if you want to use logarithmic scales.

4]	 Set the variables

I> I start

k constant

I>> Instantaneous trip 

t>> Time for I>>

5]	 Click on ”OK”

Note	 The scale is automatic and will adjust for each 
test shot.

3.2 Invoking a start-up 
condition
To invoke a start-up condition (which may consist of 
simply turning on an indicator lamp), you must high-
light it manually. 

1]	 Click on ”View” and highlight the ”Manual 
trip” button. The ”Trip” button appears. 

2]	 Start generation (ON). Click on ▼ or press ↓ 
on the keyboard. 

3]	 Click the ”Trip” button when the protective 
relay system is actuated. 

4]	 Stop generation (OFF). Click on ▲ or press ↑ 
on the keyboard.

Tip 
Now you can fill in your own comments 
in the field “Comments for selected trip 
point”.
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3 Conduct the test 

3.3 Testing tripping times 
1]	 "Increase the current by pressing 

▲(ON+TIME) and turn the main knob/dial to 
adjust the current.".

Important 
If you want to set the current before conduct-
ing the timing test you must do the following.

2]	 Reset the ”Hold” button by clicking on it or 
by pressing the keyboard space bar.

3]	 Then activate ”Hold” again by clicking on it 
or by pressing the keyboard space bar.

4]	 Increase the current by pressing ▲ 
(ON+TIME). Repeat until the current reaches 
the desired level 

3.4 When the test is 
finished

When the test is finished, the results will appear in a 
log list. You can scroll through this list by pressing ◀ 
or ▶ on the keyboard or by clicking on the appropri-
ate buttons. If you want to delete a reading, click  the 
"Delete" button. If you change your mind, you can 
undelete the reading by clicking "Undo".

Tip 
Now you have the possibility to write 
comments for each test point. Use the 
field “Comments for selected trip point”, 
see "2.3 Manage the test" on page 11 
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3 Conduct the test 

3.5 How to save a file
1]	 To save a file, click on the ”Save” button 

2]	 Type in the file name and then click on ”OK”, 
whereupon the file will be saved and a file 
name extension of .S75 will be added auto-
matically.

3.6 Testing the same 
protective relay system 
again
The next time you wish to test the same protective 
relay system or one that resembles it closely, all you 
have to do is open the test file, whereupon all your 
settings will be invoked automatically.

1]	 Click on the "Open" button.

2]	 Click on the "New" button to clear the log 
list.

3]	 Start the test.
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3 Conduct the test 

3.7 How to use ”Custom 
help” to conduct a test

Custom help file
In the “TEST SETTINGS” window you will find the 
“CUSTOM HELP FILE” line. Here you can enter the 
name of a user-written help file. You can write this 
file in WordPerfect, Word or Write or you can prepare 
a Windows help file in HLP format. Illustrations can 
be inserted via a scanner or via Paintbrush or the like. 
You can explain how to test a specific protective relay 
system and clarify your explanation with illustrations. 
This help file can then be linked to the test file that 
is saved after the test is concluded. Different help 
files can thus be linked to tests conducted at differ-
ent times. This enables you to write test instructions 
well in advance of testing. Then, at test time, a single 
mouse click will open the help file containing your 
instructions, thereby simplifying testing. How to use 
”CUSTOM HELP“ is explained below.

1]	 Click the ”Custom Help” button. 

2]	 The file specified previously under ”TEST SET-
TINGS” will now be started. 

3]	 You can switch back and forth between 
SVERKER WIN and WP/Word by pressing 
Alt+TAB on the keyboard. 

3.8 How to generate a 
report
A]	 If you wish to read through the report in 

advance on your screen, click on the ”Print 
Preview” button. 

B]	 To print the report, click on the ”Print” but-
ton.

C]	 You can also export the test file to a spread-
sheet program such as Excel or Quattro Pro 
where the table can be converted to a chart 
and the report’s appearance can be en-
hanced. 

1]	 Set the delimiter using ”System Setup” in the 
”File” menu 

2]	 In the SVERKER WIN window, click the but-
ton  on the button-bar. 

3]	 Specify the same file name as that assigned 
to the test file. The file name extension will 
become .E75 automatically. 

Note	 The printout is not working if there is no 
printer driver installed. This is also valid for 
”Print Preview”. To solve this, select a local 
printer (even if there is no local printer con-
nected) when you make ”Print Preview”. 

Change logotype in the report
Exchange the file ”logo.bmp” in C:\Program files\
Sverker Win\ to your logo file in bmp file format.

Change the report design
The report templates can be changed. For more infor-
mation see the full manual “List&Label – The Report 
Designer”. Start the report designer (List&Label) from 
SVERKER Win menu, ”File”, ”Design”.
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4 Report design 

4 Report design 

4.1 General
With the report generator it is possible to change the 
design of the reports. It is quite easy to change the 
layout of the report by adding lines, text and pictures.

Here is a short introduction in how to use the 
List&Label Report Designer. For more detailed infor-
mation see the List&Label manual as a pdf-file (in 
English or German language only). You will find the 
file under “Program”, “Programma”, “Sverker Win”, 
“List & Label Report Designer Manual”.

Templates
To make reports you use different templates. The tem-
plates are different types of list files (LST-files). You can 
edit the templates your self, some parts are quite easy 
to edit some parts not so easy.

Change logotype
Exchange the file ”logo.bmp” in C:\PETOOLS\REPORT 
to your logo file in bmp file format.

4.2 Edit the report layout
1]	 Click “File”, “Design” in the menu to start the 

List&Label report designer. You will see the 
picture below.

Layers
In the ”Layers” window you can open or close the 
different layers.

Base layer
The ”Base layer” show the objects that will be printed 
on every page.
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4 Report design 

Note!	 All objects you create on the “Base” layer will 
be shown on all pages. If you want them only 
to be shown on the first page, make sure you 
have selected the “First page” layer only. You 
can also mark an object, right-click and select 
“Assign to layer”.

First page layer
The first page shows the objects that will be printed 
on the first page.

Following pages layer
This layer shows the objects for the page(s) after page 
one. In this case the table continues on he next page 
if it did not fit into page one.
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4 Report design 

4.3 Tools

Objects > Select

Objects > Insert > Text

Objects> Insert > Line

Objects > Insert  Rectangle

Objects > Insert > Ellipse/Circle

Objects  Insert > Picture

Object > Insert > Bar code

Objects > Insert > Table

Objects > Insert > Formatted text

Move objects
Use the ”Select” button and click on the object. Put 
the pointer to the square in the center of the object 
and drag it into the new position.

Add text fields
1]	 Click the ”Insert text” button. 

2]	 Mark an area where to place he text.

3]	 Right click and select ”Properties”.

4]	 Click the ”Insert paragraph” button, or double 
click on the ---(blue line).

5]	 Select the ”Text” tab.

6]	 Insert the text in the upper field.

7]	 Click the ”Insert” button.

8]	 Click ”OK”.

9]	 Select font.

10]	Click ”OK”.

Insert lines
Use the ”Insert line” button, drag the line from start 
to end.

Insert rectangles
Use the ”Insert rectangles” button, drag the rectangle 
with the mouse.

Multiple copies
Multiple copies are good to use e.g. when you want 
to make a table.

1]	 First create a rectangle.

2]	 Select it with the ”Select” button.

3]	 Right click and select ”Multiple copies”.

4]	 Define the number of copies, in columns and 
rows.

Group
1]	 Select the objects to group. 

2]	 Click the ”Select” button and use <Shift>+left 
mouse button to mark the objects, or mark 
several objects in an area using the mouse. 

3]	 Right click and select ”Group” This can  be 
very good when you e.g. have used ”Multiple 
copies”.
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4 Report design 

Ungroup
Select the object to ungroup. Right-click and select 
”Ungroup”.

Align

Using these buttons you can align different objects. 
Align to the left, right, up or down. You can also get 
the same size for horizontal and vertical.

1]	 Click the ”Select” button and use <Shift>+left 
mouse button to mark the objects, or mark 
several objects in an area using the mouse. 

4.4 Edit text in tables
SVERKER Win will automatically change the column 
names when you change language in “File”, “Lan-
guage”.

If you want to change the column names to a name in 
a language which is not selectable from the additional 
language list you should do as follows.

1]	 Select the “First page” layer. 

2]	 Select the table. 

3]	 Right-click and select “Properties”. 

4]	 Select the line (column name) you want to 
edit.

5]	 Click the ”Edit line” button
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4 Report design 

6]	 Change the text to what you want, but be 
sure that it is within “brackets”.

7]	 Click “OK”.

8]	 Now do the same for the other columns and 
also for the columns on the “Following page” 
layer.

4.5 Save report templates
The report template you have created should be saved 
as an LST-file in,  
C:\Program Files\SVERKER WIN\ 
By doing this you can later on elect it from “File”, 
“Select report”.

Report templates

Standard_Report.lst
This report is designed for testing in Normal mode, 
e.g. overcurrent test. 

Reclose_Report.lst 
This report is designed for testing in Reclose and 
Trip+pulse mode.

Design help for report templates
For more information on how to make report tem-
plates you can use the built in help from List&Label, 
as pdf-file  (only available in English or German 
language). You will find the file under “Program”, 
“Programma”, “Sverker Win”, “List & Label Report 
Designer Manual”.
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5 Troubleshooting 

5 Troubleshooting 

Fault Cause Remedy
No communication SVERKER not unlocked 

The message “The SVERKER you 
are connected to doesn't have any 
key for SVERKER Win installed!” 
appears on the screen.

Unlock it, see "2.1 Starting  
SVERKER Win" on page 9.

Wrong com port Change com port on the PC or change the setup 
in ”File”, ”System setup”.

Wrong cable The cable between SVERKER and PC is not the 
correct type, it must be a straight pin-to-pin cable, 
1-1, 2-2, 3-3,….9-9.  
Change cable.

The Print preview and 
the printout is not 
working

You have no printer installed Install a printer driver

Times are not being 
measured

A. You have selected ”Internal 
STOP”

Change to ”Make” or ”Break”

B. ”Voltage” has been selected Select ”Contact” instead.

Custom Help won’t 
start

A. There is no associated file See the Windows manual
B. Word is not installed Instal Word

Excel don’t show cor-
rect figures

Wrong delimiter Check the settings of the delimiter in ”File”, ”Sys-
tem setup”. 
In Excel or in the Windows ”CONTROL PANEL”, 
from the ”NUMBER FORMAT” menu, select ”Full 
stop” as the correct delimiter.
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Your “One Stop” Source for all your electrical test equipment needs

Megger is a leading global manufacturer and supplier 
of test and measurement instruments used within the 
electric power, building wiring and telecommunication 
industries.

With research, engineering and manufacturing facilities 
in the USA, UK, Germany and Sweden, combined with 
sales and technical support in most countries, Megger 
is uniquely placed to meet the needs of its customers 
worldwide.

Megger is certified according to ISO 9001 and 14001. 
Megger is a registered trademark.

Postal address:
Megger Sweden AB
Box 724
SE-182 17  DANDERYD
SWEDEN

T	 +46 8 510 195 00
E	 seinfo@megger.com www.megger.com 

Visiting address:
Megger Sweden AB
Rinkebyvägen 19
SE-182 36  DANDERYD
SWEDEN

▪▪ Battery Test Equipment

▪▪ Cable Fault Locating Equipment

▪▪ Circuit Breaker Test Equipment

▪▪ Data Communications Test Equipment

▪▪ Fiber Optic Test Equipment

▪▪ Ground Resistance Test Equipment

▪▪ Insulation Power Factor (C&DF) Test Equipment

▪▪ Insulation Resistance Test Equipment

▪▪ Line Testing Equipment

▪▪ Low Resistance Ohmmeters

▪▪ Motor & Phase Rotation Test Equipment

▪▪ Multimeters

▪▪ Oil Test Equipment

▪▪ Portable Appliance & Tool Testers

▪▪ Power Quality Instruments

▪▪ Recloser Test Equipment

▪▪ Relay Test Equipment

▪▪ T1 Network Test Equipment

▪▪ Tachometers & Speed Measuring Instruments

▪▪ TDR Test Equipment

▪▪ Transformer Test Equipment

▪▪ Transmission Impairment Test Equipment

▪▪ Watthour Meter Test Equipment

▪▪ STATES® Terminal Blocks & Test Switches

▪▪ Professional Hands-On Technical and  
Safety Training Programs

▪▪ AUSTRALIA
▪▪ BULGARIA
▪▪ CANADA
▪▪ CZECH REPUBLIC
▪▪ CHINA
▪▪ FRANCE
▪▪ GERMANY
▪▪ HUNGARY
▪▪ INDIA
▪▪ INDONESIA
▪▪ KINGDOM OF BAHRAIN
▪▪ KOREA
▪▪ MALAYSIA
▪▪ PAKISTAN
▪▪ PHILIPPINES

▪▪ POLAND
▪▪ ROMANIA
▪▪ RUSSIA
▪▪ SINGAPORE
▪▪ SLOVAK REPUBLIC
▪▪ SOUTH AFRICA
▪▪ SPAIN
▪▪ SWEDEN
▪▪ SWITZERLAND
▪▪ TAIWAN
▪▪ THAILAND
▪▪ UNITED ARAB EMIRATES
▪▪ USA
▪▪ VIETNAM

Megger Group Limited 
UNITED KINGDOM 
Dover, Kent CT17 9EN 
ENGLAND
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